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Introduction

Congratulations and thank you for buying the Sony Ericsson Edge PC Card Modem GC82. The 
GC82 is a standard size type II PC card for GSM/GPRS/EDGE at 850 and 1900 MHz, enabling 
laptop users to have mobile access to the internet or corporate network with flexibility and high 
speed, including ‘always online’ capability via GPRS/EDGE. The GC82 is very simple to install and 
use; the software provided allows you to select the best data service available so that the GC82 is 
always available for data transfer.

The GC82 enables your laptop PC to:

• Browse the Internet

• Send and receive e-mails

• Receive information services in real time

• Access files, databases and discussion groups

• Send and receive SMS text messages

• Edit SIM card entries

Note:
Before using your GC82 you MUST read Important Information on page 48.

Hardware Overview

The GC82 is a standard type II PC card. The card is standard length and only the antenna protrudes 
outside the PC card slot. 

The amount of power drawn from the laptop battery is dependant upon a number of factors including 
status, distance to the base station and number of timeslots used. See Technical Specifications on 
page 51 for a general guide to power consumption.

Before you can start using the GC82 you need to put the hardware together. You will also need a SIM 
card.

SIM Card
When you subscribe to a mobile network operator, you are issued with a SIM card (Subscriber 
Identity Module card). The SIM contains your personal subscriber data. You need a SIM 
to use GC82.
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Software Overview

GC82 Manager
You can use the GC82 Manager to:

• Display GC82 status information

• Create or modify connection settings

• Connect to the Internet or a corporate network

• Manage GC82 settings

• Manage SIM card and PC phone books

• Send and receive SMS messages

Using the GC82 with your Applications

Data Programs
You can use the GC82 as a modem to provide Intranet/Internet connectivity for a wide range 
of applications. 

Fax Programs
You can use the GC82 as a fax provided you have the correct software, e.g. Microsoft Fax 
(Windows 2000 and XP).

Documentation

The GC82’s documentation is designed to enhance your understanding of its capabilities. 
The following guides are provided:

• A printed Quick Start Guide aimed at getting you operational as quickly as possible.

• An online User’s Guide (this document) containing a comprehensive description of the GC82 
functionality. You can read the guide on the computer screen or print it on to either European 
A4 or American Letter sized paper.

The User’s Guide is located on GC82 CD-ROM as Adobe Acrobat PDF files. The GC82 CD-ROM 
also contains Adobe Acrobat Reader® which you can install if necessary.

Illustrations
The illustrations in this manual were obtained using the GC82 on a Microsoft Windows® 2000 
operating system. The dialogs that appear on your PC may differ depending on the version 
of Windows® in use.
6 Introduction



Getting Started

Checklist

Make sure the following items are in the box when you unpack it:

• Protective case for storing the GC82 and its antenna

• GC82 PC Card

• Antenna

• Quick Start Guide

• CD-ROM
The CD contains; drivers, software, documentation and a readme file.

System Requirements

This section lists the network subscriptions, hardware and software requirements for running 
the GC82 PC Card.

Network and Subscription
The network subscription you use in conjunction with your GC82 depends on the subscriptions your 
network operator can provide. Contact your network operator or service provider to make sure the 
options you require are available. Make sure that data options are included in your subscription, 
as these are usually optional services.

Note:
Mobile operators often provide a number of connectivity options via GPRS such as WAP and 
Internet, so check that the Internet or VPN service you require is enabled for your subscription.

The functionality of the different subscriptions available from networks operators are 
discussed below:

Circuit Switched Data (CSD)
CSD is the original GSM network data transfer method, used in the past for WAP. Almost all GSM 
networks have this capability at 9.6 kbps. It is possible for the network to upgrade the speed 
to 14.4 kbps. The GC82 operates at this higher speed where available.

General Packet Radio Service (GPRS)
GPRS is a new network connection which provides “always on” mobility. The connection set up 
is fast and, once connected, applications may send and receive data whenever required. In today’s 
GPRS networks, the GC82 receives data at speeds up to 53.6 kbps and transmits at speeds 
up to 26.8 kbps. 

Enhanced Data Rates for Global Evolution (EDGE)
EDGE enhances GPRS by increasing data throughput by a factor of 3. GPRS networks enhanced 
with EDGE are often referred to as E-GPRS (Enhanced GPRS) networks. EDGE provides the 
“always on” capability of GPRS but with greater speed. EDGE technology is transparent, simply 
Getting Started 7



make a GPRS connection as usual and benefit from the increase in speed where EDGE is available 
in a network.

Short Message Service (SMS)
The PC can send and receive SMS text messages using the SMS Messages screen in the GC82 
Manager, see GC82 Manager SMS Messages Screen on page 34, for more details. 

Hardware
You will need:

• A PC that has the minimum specification recommended by Microsoft to run the version 
of Windows® installed on it.

• A 16 bit type II PC Card slot.

• Sony Ericsson Edge PC Card Modem GC82

• a SIM card

Software
You will need:

• Windows® 98SE, Me, 2000 (SP2) or XP.

• Sony Ericsson GC82 Manager CD-ROM.

Services Available Over the Internet

The Sony Ericsson web site contains support to facilitate easy communications and rapid information 
retrieval, wherever you are. It gives you access to on-line customer services, on-line user manuals, 
software downloads, and useful information. The address is:

http://www.SonyEricsson.com/support

Sony Ericsson’s home page address is:

http://www.SonyEricsson.com
8 Getting Started
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Installation

The GC82 Manager CD-ROM contains the software required to operate your GC82. The software 
is simple to set up and operate, but before you begin you will need to make sure that the services 
you require are included on your SIM card subscription. For an explanation of the services that are 
available see Network and Subscription on page 7. Contact the organization that supplied you with 
your SIM card and request that the specific services (EDGE, GPRS, CSD or SMS) you require are 
added to your subscription.

The CD-ROM contains the following software:

• GC82 Manager

• User Documentation

• On-line Help

• ReadMe text file containing the latest information about the GC82

GC82 Hardware Set Up

1. Collect your GC82 card, antenna and SIM card together.

2. Insert your SIM card into the slot on the back of GC82, with the gold contacts facing downwards

Note:
The cut corner of the SIM card must be placed into the PC card as demonstrated below, 
the gold contacts should face downwards.

3. Connect the antenna to the end of the GC82.

If the antenna is obstructing your use of the keyboard you can turn it to a horizontal position and still 
connect to the network.

If you want to use your other PC card port remove the GC82 whilst you insert the other card. See Safe 
Removal of the GC82 on page 13 for more details.

When GC82 isn't in use it is recommended that you store it in the protective carrier box provided. 
The unit, especially the antenna could be damaged if it remains in PC.
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���������	
Do not insert the card into the laptop until you have installed the software from the CD-ROM. 
Simply cancel the New Hardware wizard if the card is accidentally inserted prior to software 
installation.

Installing the Software

1. Insert the GC82 Manager CD-ROM in your CD drive.

After a few seconds a Sony Ericsson splash screen is displayed.

Note:
If the CD-ROM does not autorun, select Start  Run and type D:\Setup.exe into the Run 
dialog. (Where D is your CD drive.)

2. The Choose Language dialog opens. Click on the drop down list and select the installation 
language for your GC82 Software. Click OK.

3. The InstallShield Wizard for Sony Ericsson GC82 Manager opens; follow the instructions 
on screen. When installation is complete click Finish.

4. Insert the GC82 PC Card. Make sure the GC82 is fully inserted. 

5. After a few seconds, the New Hardware Wizard opens and installs the necessary drivers onto 
your PC from the GC82 CD. The wizard may require you to locate a specific driver file. If this 
happens a dialog opens, click Browse and select:

In the above table D is referred to as your CD drive.

Component GC82 CD-ROM Location

EDGE/GPRS Drivers on a 
Windows 98SE machine

D:\Driver\Driver98 

EDGE/GPRS Drivers on a 
Windows ME machine

D:\Driver\DriverME

EDGE/GPRS Drivers on a 
Windows 2000/XP machine

D:\Driver\Driver2k

GPRS PC Card Modem

GC8
2
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Note:
When installing on Windows 98SE, Windows may prompt for the original Windows 98 
CD-ROM to be inserted. If the CD-ROM is not inserted when requested, Windows will 
subsequently reboot with error messages relating to missing files. Therefore, it is strongly 
recommended that the Windows 98SE CD-ROM is available before installation starts.

6. Select the driver file requested by the Wizard and click Open. The Hardware Wizard finishes the 
installation.

Note:
If you are prompted to reboot the laptop during software installation, you may find that the 
GC82 Manager attempts to start before all of the drivers are installed. The scenario is that the 
New Hardware Wizard is still busy installing the 3 device drivers, the GC82 Manager splash 
screen appears, followed by a warning dialog saying ”You must have a GC82 Wireless Modem 
installed to run this application. Please install a GC82 Wireless Modem and try again”. Click 
OK. Wait for the New Hardware Wizard to complete, rebooting the laptop if required, then start 
the PC Card Manager using the icon on the desktop or via Programs  Sony Ericsson  
PC Card Manager.

7. Select Programs  Sony Ericsson  GC82 Manager to start using your GC82.

8. The GC82 and GC82 Manager are ready for use. 
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Start Using GC82 Manager

1. To start GC82 Manager select Start  Programs  Sony Ericsson  GC82 Manager 
or select your desktop shortcut .

2. If requested, enter your SIM Card/Phone Lock PIN and click OK. It is only necessary to enter 
the PIN number once during a PC session.

You are allowed three attempts to enter the correct PIN code. If you fail to enter the SIM PIN 
correctly it is blocked and if you fail to enter the Phone Lock PIN correctly your GC82 is locked. 
Contact your network operator for an unblock code (PUK). Enter the unblock code into the Card 
Blocked dialog and enter a new PIN code and confirm it. 

To set the SIM Card PIN and Phone Lock PIN, see Locks on page 28.

3. The Radio dialog opens, select the required state for your GC82 radio transmission. 
See GC82 Manager Preferences on page 15 for more details.

4. The GC82 Manager opens, displaying the Status screen. Connectivity details are displayed 
on this screen, the current signal strength and GPRS availability should be listed. See GC82 
Manager Status Screen on page 25, for more details.

5. The GC82 Manager Icon is displayed in the system tray of your PC.

GC82 Manager Icon

The GC82 Manager Icon shows the current status of the GC82, which is typically the current network 
signal strength and the GSM/GPRS/EDGE service status, similar to a mobile phone display. If you 
right click on the GC82 Manager Icon a menu is displayed, see The GC82 Manager Icon Menus 
on page 14 for details on the menu options.

Place your mouse cursor over the GC82 Manager Icon to display text indicating:

• GSM or GPRS/EDGE Service availability

• Network name

• Connection information

Three standard Windows® operating system icons also appear in the system tray when the GC82 
is inserted in your PC and connected. They are the Sony Ericsson Wireless WAN Adapter icon, 
Dial-up Networking icon and the PC card icon.

2:07 PM1:07 PM

GC82
PC Card icon

Sony Ericsson Wireless WAN 

GC82 Manager IconPC Card icon

Sony Ericsson Wireless WAN
Dial-up 

Adapter icon (disconnected)Adapter icon (connected)
Networking iconManager Icon
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• Making Windows Network Connections Visible
The Windows connection icons, displayed in the system tray, normally disappear once a 
connection is made. This means that you may not necessarily see a icon corresponding to each 
of the icons for your GPRS/EDGE and CSD. 
To make a icon visible, follow the steps described below.

• Right click the appropriate icon and select Open Network Connections. Alternatively 
select Start  Settings  Network Connections.

• A dialog opens displaying all the network and dial-up connections available on your PC. 
Right click the one you want to edit.

• Click the Show icon in taskbar when connected box. Click OK to close the dialog.
When you have an active connection use your mouse to hover over the icon to view 
connectivity details.

• PC Card icon
Indicates that a PC card is present and allows the user to see certain properties and also 
to stop/remove the card. 

Safe Removal of the GC82
You must stop the GC82 before attempting to remove it. 

1. Close any active GC82 Networking Connections.

2. Exit GC82 Manager.

3. Click on the PC Card icon. A list of currently connected PC Cards is displayed. Select Stop 
Sony Ericsson GC82 Wireless Card. 

4. A dialog is displayed telling you it is safe to remove the card.

5. The GC82 PC card can now be removed safely.

���������	
Incorrect removal of the GC82 can damage the card.

GC82 Manager Icon Status
The GC82 Manager Icon icon displays the status of the GC82 network connection. 

Radio is set to off or the GC82 Manager has disconnected the GC82

The radio transmitter is enabled, but there is no GSM or GPRS service available

The GC82 has GSM service and indicates a signal strength of 3 out of 5 bars. 
CSD, SMS and fax may be used, provided these are supported by the 
subscription. GPRS/EDGE is not available

The GC82 has GSM and GPRS service

GC82 Manager is waiting for the GC82 Card to be inserted.
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The GC82 Manager Icon Menus
Right click one of the following icons to see the GC82 GPRS/EDGE menu options.

Note:
Some of these menu options are disabled, depending on the current state of the GC82.

Note:
EDGE capability is not indicated by the GC82 GPRS/EDGE icons.

The GC82 Manager Icon menu options are described below.

Open GC82 Manager
Select Open GC82 Manager or double click on the GC82 Manager icon to open the GC82 Manager. 

Radio Status 
This menu option is dynamic. It monitors the current state of the GC82 radio transmitter and gives 
you the option to switch to the opposite state, for example, if your GC82 Radio transmitter is on the 
menu option reads Turn Radio Off. 

You can also set the status of the radio transmitter by selecting Turn Radio On/Off in the 
GC82 Manager File menu. 

Connect/Disconnect
If you are currently disconnected the menu gives you the option to connect to the most recently used 
GC82 connection. If you are connected the menu gives you the option to disconnect.

Help 
Opens the GC82 Manager Online Help. You can also launch the Online Help from the GC82 Manager 
Help Menu. Pressing F1 in any of the GC82 Manager dialogs opens the relevant help screen.

About
Displays a dialog that contains GC82 Manager software information.

Hide to Tray
Select the Hide to Tray option to visually close GC82 Manager leaving only the GC82 Manager 
Icon visible in the system tray. Use the Open GC82 Manager to view the software again.

Exit
Closes the GC82 Manager application, the GC82 Manager Icon will remain in the system tray if you 
have set it to run in the background. See GC82 Manager Preferences below for more details.

or

or

or

The GC82 GPRS/EDGE menu is displayed.

Open GC82 Manager
Turn Radio Off

Connect to MyGPRSservice

Help

About GC82 Manager

Hide to tray

Exit
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GC82 Manager Preferences

You can change the general behavior of the GC82 Manager by selecting specific options in the 
Preferences... dialog.

1. Select Preferences... in the File menu. The Preferences dialog opens, the Radio Power tab 
is displayed.

Radio Power Tab
You can use this tab to manage the state of the radio transmitter. 

Enable Radio immediately 
when card inserted

You should normally leave this checkbox turned off. 
When enabled, the Windows driver turns the radio 
transmitter on when the card is inserted and leaves 
it enabled even when the card is not in use. You should 
check this option if your Windows logon requires you to log 
on using a dial-up connection, see Windows Log on Using 
GPRS/EDGE Dial-up Connection on page 19 for more 
details. When you click OK to activate this option the 
GC82 Manager displays the following dialog.

When this option is selected, the GC82 Manager radio 
power startup and shutdown choices are disabled.
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The radio mode you specify at GC82 Manager start-up appears selected on the Radio tab.

Text Messaging Tab
You can use this tab to enable reception of specific message classes from the SMS Cell Broadcast 
service and to set the SMS received audio alarm to on or off. Select the radio buttons to activate 
the options.

Example of SMS Cell Broadcast message types:

To enter multiple SMS Cell Broadcast message types separate each entry with a comma, 
for example, 000, 034, 076.

Note:
SMS Cell Broadcast message types are network operator specific. Contact your network 
operator for more details.

This screen also allows you to set a validity period for the SMS messages that you are sending. 
If your message can not be delivered, for example, if the recipient hasn’t inserted their GC82, 
the validity period tells your service centre how long to keep trying to send the message.

On When the GC82 Manager is running in radio on mode 
it is registered to the network and connections can 
be made and SMS sent and received. The radio can 
be enabled in several ways; 
• Select Radio On when the GC82 Manager starts.
• Specify the required radio state in 

Preferences Radio Power.
See GC82 Manager Preferences on page 15 for 
more details.

Off Radio Off indicates that the GC82 will not register to the 
mobile network. You may perform non-communication 
related activities such as phone book maintenance, but 
you must turn on the radio in order to make a connection 
or to send/receive SMS.

Ask Me Triggers a dialog to be displayed every time the PC 
is turned on. The dialog asks you if the radio transmitter 
should be turned on or off during the active PC session. 
This is also called Aeroplane mode, because it prevents 
the radio transmitter automatically turning on. This is 
a useful feature in areas where radio transmitters are 
not allowed; aircrafts, hospitals or blasting areas.
Your GC82 is set to Ask by default.

Turn Radio Off At shutdown the radio is turned off.

Reset card Turns the radio off and resets the card.

Code: Cell Broadcast Message
000 Index

010 News Flashes
020 Hospitals

030 Long-distance road reports

040 Weather
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Notifications Tab
Click the Notifications tab. You can decide if you want to display a splash screen every time GC82 
Manager is opened or closed and a program end confirmation box. Select the radio buttons to activate 
the options. 

GPRS Connection Tab

Establish GPRS connection at startup
Select this option to automatically connect to your chosen network when GC82 Manager is started. 
GC82 Manager waits until GPRS is registered and then it establishes the specified GPRS connection. 
Simply select the name of the connection to be established from the drop down list.
To automatically connect when you start or restart your PC see the example below. If you need 
to connect at Windows log on see Windows Log on Using GPRS/EDGE Dial-up Connection 
on page 19.

Example: If you want your GC82 to be available and a GPRS internet connection 
to be automatically established when you boot your laptop: 
- Set Preferences  Miscellaneous  Run this program when 
Windows Starts 
- Set Preferences  GPRS Connection  Establish GPRS Connection 
At Startup and select the GPRS connection required. 

Miscellaneous Tab
Click the Miscellaneous tab.
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• Hide to tray when minimized
If enabled, when the GC82 Manager is minimized, it removes any window from the taskbar, 
and only shows the small icon in the system tray. To re-open the main window, double-click 
the tray icon, or select open from the icon menu.

• Run this program when Windows starts
If enabled, the GC82 Manager starts when Windows is started. If a GC82 PC Card is detected, 
the GC82 Manager runs. If not, the program closes (and runs in the background if permitted). 
When used with Establish GPRS connection at startup, this allows a GPRS session to be 
automatically connected when the user logs on, see Windows Log on Using GPRS/EDGE Dial-
up Connection on page 19 for more details.

• Minimize when Windows starts
If enabled, the GC82 Manager starts when a user logs on to Windows, it appears as an icon in 
the task bar only. If a GC82 PC Card is detected, the GC82 Manager runs and connects. If not, 
the program closes (and runs in the background if permitted). 

• Allow this program to run in the background
If enabled, the GC82 Manager runs in the background, waiting for a GC82 PC Card to be inserted. 
When the card is detected, the GC82 Manager automatically opens and begins normal operations. 
When the close box, or File  Exit is selected, the GC82 Manager closes but does not exit. 
It releases control of the card, so it may be stopped and removed, and runs in the background. 
You can start the program again from the Start menu, double-clicking the system tray icon, 
or by re-inserting the GC82 PC Card.
You can stop GC82 Manager running in the background by right clicking on the PC screen and 
selecting Exit. 
If you attempt to start GC82 Manager with no GC82 Card inserted a warning dialog is displayed, 
informing you that the GC82 PC Card is not present, and GC82 Manager switches back 
to background mode.

• Hide tray icon when no card inserted
If this option is selected, GC82 Manager runs in background mode, the GC82 Manager icon 
is not displayed in the system tray. If the card is inserted, the icon reappears and the GC82 
Manager is started.

• Show menu item for Modem Software Update
If this option is checked, a File  Modem Software Update... menu item is enabled. Selecting 
this menu command prepares the modem to receive a software update from the Sony Ericsson 
Update Service. More information about this service can be found at 
http://www.sonyericsson.com/updateservice/GC82/.

Examples: If you want to activate your GC82 when the laptop is booted, so that it is ready 
to make a connection and send/receive SMS:
- Set Preferences  Miscellaneous  Run this program when Windows 
Starts.

If you want your GC82 to be available and a GPRS internet connection 
to be automatically established when you boot your laptop: 
- Set Preferences  Miscellaneous  Run this program when Windows 
Starts.
- Set Preferences  GPRS Connections  Establish GPRS Connection 
At Startup.
- Select the GPRS connection required. 

If you remove the GC82 during usage and want it to be automatically reactivated 
when you re-insert it:
- Set Preferences  Miscellaneous  Allow this program to run in the 
background.
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Note: If you have Establish GPRS connection at Startup set, then the connection 
will also be automatically established when you insert the card. 

If you want to start the laptop with the GC82 removed and have it automatically 
activated when it is later inserted: 
- Set Preferences  Miscellaneous  Run this program when Windows 
Starts. 
- Set Preferences  Miscellaneous  Allow this program to run in the 
background.

Class 0 SMS Messages

Class 0 messages contain current information and are replaced frequently, for example, traffic 
reports. The GC82 will display any messages that are sent out whilst it is registered on a network. 

Windows Log on Using GPRS/EDGE Dial-up Connection 

The GC82 PC Card supports the Windows Log on using dial-up connection feature.

To log on to Windows using a dial-up connection the GC82 PC Card must be inserted and the radio 
enabled before you log on. To enable the radio prior to logon, select Enable radio immediately 
when card inserted checkbox on the Radio Power preferences tab, see Radio Power Tab 
on page 15 for more details.

���������	
Never start your PC in this mode if you are in a location where mobile devices shouldn’t 
be used, for example, on an aeroplane, in hospital or near a blast site.

Only check this option if you need to log on to a Windows Domain via a wireless dial-up connection. 
This will permit the GC82 to register with the network and establish a connection when the Windows 
logon screen is displayed.

Note:
It is not possible to display network status or signal strength during the Windows logon 
procedure, so you should allow enough time for the GC82 to find and register with the wireless 
network prior to attempting to log on.

The dial-up connections available to the Windows Logon must have been created by a user account 
with Administrator privilege and designated For all users. This must be done using the Windows 
Network Connection Wizard, because the GC82 Manager can only create connections for the 
current user ID.

Normally the Windows Logon using dial-up connection will be using a CSD session to a corporate 
network, so that the logon credentials can be validated by a Windows Domain Server. 

There may be special circumstances where a GPRS dial-up connection is required for logon. 
To create a GPRS dial-up connection, follow these steps:

1. Create the Windows dial-up connection using the Windows Network Connection Wizard. 
For the telephone number, use *99***3#. 

2. Set the GPRS context parameters in the GC82 PC Card using the following AT commands. 
Type the AT Commands into the Windows Hyperterminal program.

AT+CGDCONT=3,“IP”,“<AccessPointName>”,“”,0,0 
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where <AccessPointName> is the name of the special GPRS access point for your corporate 
GPRS service.

Note:
In this example, we used GPRS Context 3. There are 10 possible contexts supported 
by the GC82 PC Card (1..10). Context ID 2 is reserved for use by connections created 
by the GC82 Manager.

Refer to the GC82 PC Card AT Command Manual or contact your service provider for further 
assistance.
20 Start Using GC82 Manager



Create a Connection

1. Click  or select View  Connection Wizard. The Connection Wizard opens.

2. Select the radio button next to Create a new connection, enter a name, for example ‘My 
Connection’, click Next.

Note:
Your connection name should not exceed 16 characters for it to be fully visible in GC82 Manager.

3. The Type of Connection screen opens. From here you select the type of connection you require:

• For GPRS/EDGE see steps 4 to 8

• For CSD see steps 9 to 12

GPRS Connection

4. Select GPRS/EDGE. Select your Network Operator from the Choose Network drop down list. 
If your Network Operator isn’t listed selected <Other>. Click Next. 
See Network and Subscription on page 7 for more information on GPRS.

Note:
Type the first letter of the Network Operator you require into the field to list all the operators that 
start with that letter.

5. The Access Point Name dialog opens. Your Network Operator’s Access Point Name or Names 
(APNs) are displayed, select the APN you want to use. If no APNs are listed contact your 
Network Operator and ask them to supply an APN. 

6. To modify the selected APN’s settings, Click Advanced.... See Appendix A - Connection 
Parameters on page 61, for descriptions of the updateable parameters in the Advanced dialog. 
Click Apply to save any changes before closing the dialog. Click Next.

Note:
Your connection will automatically switch to EDGE when the network is available, allowing your 
PC Card to work at faster speeds.

7. If you have a logon for your service provider, enter you User ID and Password into the specific 
fields. If you don’t need a username and password to connect leave the fields blank. Click Next.

Note:
Some versions of Windows® deliberately change the number of asterisks that represent 
a password and place asterisks in the password field when the password is blank in order 
to make the display secure.

8. Click Finish to create your connection or Back to review your settings.
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CSD Connection

9. Select CSD. Select your service provider from the Choose Network drop down list. If your 
service provider isn’t listed select <Other>. Click Next.

10. If you selected a Network Operator from the Choose Network drop down list, the telephone 
number screen should be automatically filled in. 
If you selected <Other> from the Choose Network drop down list; enter the number you need 
to dial to connect to your Network Operator in the Telephone Number field; include your 
country and area code. Ensure Use Area Code and Country Code is de-selected.

Note:
Contact your Network Operator for a telephone number if necessary.

11. Click Advanced.... you can specify your preferred CSD network connection speed from the 
drop down list and the method you want to use to connect to the network, on the Speed tab of 
the Advanced dialog. Click Next. 

Note:
If you are unsure which speed to choose from the Speed tab, start with Analogue 9600, 
and check to see if it works. Once your connection works on Analog, you can try the V110/V120 
settings to see if faster speeds are available. V110/V120 also connects faster than analog. When 
roaming you may need to repeat this procedure to adapt your settings to the capability of the 
local network operator.

12. Select the Options tab in the Advanced dialog to specify 
a callback number, if required. Callback is a service that allows 
the call direction to be reversed. If you want to watch the progress 
of a callback in a terminal window click the Show Terminal 
Window After Dialing box.

See Appendix A - Connection Parameters on page 61, 
for descriptions of the updateable parameters in the Advanced dialog. Click Apply to save 
any changes before closing the dialog. 
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13. If you need a User ID and Password to logon to your service provider enter them into the 
specific fields. If you don’t need a username and password leave the fields blank. Click Next.

Note:
Some versions of Windows® deliberately change the number of asterisks that represent 
a password and place asterisks in the password field when the password is blank in order 
to make the display secure.

14. Click Finish to create your connection or Back to review your settings.

TCP/IP Optimisation

To take full advantage of the high bandwidth of the GC82, the TCP/IP packet size should be changed 
from the default Windows setting of 16k for Windows 2000, or 64k for Windows XP. Sony Ericsson 
recommends a TCP/IP packet size of 52k for optimum performance with the PC Card. 

The Windows Registry parameter to be changed is ‘TCPwindowsize’, at the registry location:

HKEY_Local_Machine\System\CurrentControlSet\Services\Tcpip\Parameters\

The required ‘TCPwindowsize’ entry is:

HKLM\SYSTEM\CurrentControlSet\Services\Tcpip\Parameters\

However, a PC that has not previously had its TCP/IP packet size changed from the original default 
value will not have a ‘TCPwindowsize’ parameter entry, and thus a new entry must be created.

Caution!
This setting affects all network adapters in the PC and therefore should only be changed by 
experienced users.


������	
Make a backup of the registry before making any changes.

Modify a Connection

1. Select Modify a Connection. The Select a Connection drop down menu is activated. 
Click on the menu and select the connection you want to modify.

2. Click Next. 

3. Change settings as required.

Delete a Connection

1. Select Delete a Connection. The Select a Connection drop down menu is activated. 
Click on the menu and select the connection you want to delete.

2. Click Next. The Success screen is displayed. Click Finish to close the Connection Wizard.
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Using your Connection

To Connect
1. Open GC82 Manager.

2. If requested enter your SIM Card PIN and click OK. The Status screen is displayed.

3. Select the connection you require from the drop down list and click Connect.

To disconnect an active connection
1. Click Disconnect on the Status screen.

The GC82 Manager ends the connection.

Alternatively:

Right click on the GC82 Manager icon in the system tray and select Disconnect.

Note:
You can also use the Preferences dialog to set up auto connection when the GC82 Manager is 
opened. See GC82 Manager Preferences on page 15 for more details.

Browse the Internet

You can connect to the Internet using a CSD or GPRS/EDGE connection:

1. Open your preferred connection from the Status screen. See Using your Connection above for 
details on opening a connection.

2. Start your Internet browser. You are online and can browse the Internet.

Send and Receive emails

You will need an email program installed on your PC in order to send and receive emails. You can 
send and receive emails using a CSD or GPRS/EDGE connection:

1. Open your preferred connection from the Status screen. See Connection on page 26 for details 
on opening a connection.

2. Start your email program. You are online and can send and receive emails.
24 Create a Connection



GC82 Manager Status Screen

The Status Screen is displayed when GC82 Manager opens. You can also open the Status screen 
by clicking  or selecting View  Status.

The Status screen shows detailed SIM card and network status information. 

The left side of the screen shows graphical icons, representing:

• Receive signal strength

• GPRS/EDGE service status

• Unread SMS Text Message  status (or SIM Full indication ). See GC82 Manager 
SMS Messages Screen on page 34 for more details.

• Connection status

The left side of the screen also displays:

• The current Network Status, e.g. searching, radio off

• The connection progress messages

The right side of the Status screen displays connection details. When a connection is established, 
the connection statistics (duration, bytes transmitted, bytes received) are displayed and updated 
at regular intervals.

Note:
Statistics display is not supported on Window 98(SE) or Me platforms. To view statistic data 
when using these operating systems hover your mouse cursor over the standard Windows Dial-
up Networking icon.

SMS
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Connection

To connect, cancel or disconnect a GPRS/EDGE or CSD data session 
use the Connect/Disconnect drop down menu. The menu displays all the 
connections you have defined, so you can quickly select the required 
connection. 

The Control button, located underneath the drop down menu, changes it’s 
appearance depending on the state of the GC82 connection. The button 
allows you to:

• Initiate a connection (Connect)

• Cancel connection attempt (Cancel)

• Disconnect (Hang-up) an existing session

To create a connection see Create a Connection on page 21.

Note:
You can also launch or terminate a CSD dialup networking sessions directly from the Windows 
Network Connections icon. 
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GC82 Manager Telephony Settings Screen

The Telephony Settings screen allows you view and change the GSM settings of the GC82.

The functions of the Telephony Settings screen are very similar to the settings that you have access 
to via a mobile phone’s display.

Note:
Your GC82 has to be connected to your computer to make changes to the settings. 

1. Click  or select View  Telephony Settings.

The window is divided into two areas: the navigation area on the left and the information area 
on the right.

When you have selected a setting in the navigation area, GC82 Manager retrieves the current setting 
information from the GC82 and displays the information in the right area.

Phone Numbers

My numbers
You can list all your own numbers here. The numbers are for personal reference only and have 
no operational effect on the GC82.

Voice line 1 and 2:
The voice number or numbers issued with your SIM card that you use for normal voice calls. 
If you have line 2 (alternate line service) enter in the Voice Line 2 number field.
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Data:
The number used to make a data call to the GC82 (Mobile Terminated).

Fax:
The number used to send a fax to the GC82.

Click Apply when you have finished, to transfer the changes back to your GC82. This may take 
a few seconds.

SMS Service Centre
When you send a text message it goes to your operator’s service centre, they then forward it to the 
correct recipient. The SMS service centre is identified by a telephone number.

Note:
The SMS Service Centre number is normally read automatically from your SIM card.

To Set or change the service centre address:

1. Enter your operator’s service centre phone number in the Number text box.

2. Click Apply to transfer the setting to your GC82.

Locks

Phone lock
The phone lock protects the GC82 against unauthorized use if it is stolen and used with another 
SIM card. Phone Lock is not activated when you buy the GC82. 

You can use this screen to change the default security code (0000) to any four to eight digit 
personalized code.

You can set the Phone Lock Status to one of the following states:

• On - A brief message Phone lock is displayed each time you turn on the computer. The Enter 
phone lock code dialog opens. Enter your code into the dialog and click OK.

• Off - The GC82 is not locked.

• Automatic - If the Automatic setting is selected, the message Phone lock only appears when 
a different SIM card is inserted into the GC82. After the security code has been entered 
correctly, the GC82 can be used with the new SIM card.

Note:
The Phone Lock code has four to eight digits and is shown as asterisks upon entry in the dialog.

To Change the Phone Lock code:
1. Click . 

2. The Change the Phone Lock Code dialog opens. Make the required changes and click OK.

3. Click Apply when you have finished, to transfer the changes back to your GC82. This may take 
a few seconds.

Change Phone Code
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SIM lock
Some SIM cards are protected with a PIN (Personal Identity Number) at the time of purchase. 
If the SIM card lock is activated, you have to enter the PIN every time you turn on your PC and open 
GC82 Manager. If you enter your PIN incorrectly three times in succession, the SIM card is blocked 
and you need a PUK code, from your network operator, to unblock the SIM card. 

• To activate the SIM card lock, select the On radio button.

Caution!
Only activate the SIM card lock if you know the PIN code.

• To cancel the SIM card lock, select the Off radio button.

Note:
You have to use your PIN code to turn the SIM card lock off.

To Change the PIN Code:
1. Click . 

2. Enter your old PIN code, followed by your new four to eight digit PIN code. Confirm the new 
code by entering it again.

3. Click OK.

Note:
The SIM card lock only protects your subscription and not your GC82 from unauthorized use. 
If you change your SIM card, the GC82 will still work with a new SIM card.

4. Click Apply when you have finished to transfer the changes back to your GC82. This may take 
a few seconds.

Networks

Current Network
You can select which network you want to use by going to Networks and then choosing 
Current Network.

Searching for the available networks: 
• Click Retrieve, the current network appears in the box with all the other currently available 

networks.

The available networks will fall into one of the following three categories:

• The home network.

• Available networks, networks that your home mobile operator has a roaming agreement with.

• Forbidden networks, you can’t use these networks except for emergency calls. If your home 
network and a forbidden network come to an agreement that allows you to use the forbidden 
network, you can select this network even though it is forbidden.

Change Pin Code...
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Choosing another network:
1. Uncheck Automatically choose a network for me.

2. Select the network that you want to use.

3. Click Apply to transfer the setting to your GC82.

The message Please wait appears briefly on the screen. If you are not allowed to use the network that 
you have chosen, Forbidden is displayed.

Note:
GPRS is commonly available in GSM networks, but fewer roaming agreements are in place. 
You may therefore need to explicitly select one of the available networks in order to use GPRS 
when abroad. Check with your home operator to find out which networks are GPRS roaming 
partners in the country or region in which you want to roam.

Preferred (network)
A list of preferred networks is stored on the SIM card. This is typically set up by your mobile 
operator as part of SIM manufacture. Preferred roaming partners are placed in the list so that you 
have the greatest range of available services when roaming. When the home network is not available, 
the GC82 will check the available networks against the preferred network list and select the one 
placed highest. Automatic network selection must be enabled.

If you want to add a new network:

1. Click Add, a new dialog with all the networks known to the GC82 appears on the screen.

2. Select the network that you want to add and click OK.

3. Click Apply to transfer the setting to your GC82 SIM card.

If you want to delete a network from the list:

1. Select the network that you want to delete.

2. Click Remove.

3. Click Apply to transfer the setting to your GC82 SIM card.

If you want to re-arrange the order of the networks listed:

1. Select the network that you want to move.

2. Click the Move Up or Move Down arrows to rearrange the order.

3. Click Apply to transfer the setting to your GC82 SIM card.

Note:
If the list of preferred networks is full, the Add button is disabled (grey).

Divert Calls

Note:
The GC82 does not make or answer voice calls. The divert function enables you to send 
a voice call to an alternative number where it can be answered. For example, the mobile 
network voicemail service. However you can make and answer fax and data calls, providing 
you have appropriate software on your PC to handle them.
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All
If you want to make certain that all your incoming calls are taken care of when you cannot answer 
them, you can use the Call divert service to divert them to another number that can handle the types 
of calls you expect to receive.

Note:
The Call divert service may not be available on all networks. 

Selecting a call divert setting:
1. To obtain your current call divert settings from the network, click Retrieve.

2. Make your changes by identifying when you want to divert your incoming calls. You can select 
from four different diversion options:

– Always: this diverts all incoming calls to the phone number that you have entered in the 
text box

– When busy: for example, on CSD calls

– No reply

– Not reachable: for example, when your phone is turned off

3. If you know which number to divert your calls to, then type the number in the text box next 
to the divert option you have chosen. 
Or 
Click  to choose a phone number from your phone book.

4. Click Apply, to transfer your new settings to your GC82. This may take a few seconds. 

Your call divert setting has now been stored in the network.

Voice
You can use the Call divert service to divert your voice calls to another phone number.

Note:
The Call divert service may not be available on all networks. 

Selecting a call divert setting:
1. To obtain your current call divert settings from the network, click Retrieve.

2. Make your changes and select in which situation you want to divert your incoming calls. 
You can select from four different diversion options:

– Always: this diverts all incoming calls to the phone number that you have entered in the 
text box

– When busy

– No reply

– Not reachable: for example, when your phone is turned off

3. If you know which phone number to divert your calls to, type the number in the text box next 
to the divert option you have chosen. 
Or
Click  to choose a phone number from your phone book.

4. Click Apply to transfer them to your GC82. This may take a few seconds. 

Your Line 1 divert setting has now been stored in the network.
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Fax
If you want to route your incoming fax calls to another number, you can use the Call divert service.

Note:
The Call divert service may not be available on all networks. Also, if you are using the 
Call restricting function, this may influence Call divert.

Selecting a fax divert setting:
1. To obtain your current fax divert settings from the network, click Retrieve.

2. Select Always if you want to divert all the incoming calls to a specific phone number. 

3. If you know which phone number to divert your calls to, type the number in the text box next 
to Always. 
Or 
Click  to choose a phone number from your phone book.

4. Click Apply to transfer your settings to your GC82. This may take a few seconds. 

Your fax divert setting has now been stored in the network.

Data
If you want to route your incoming data calls to another number, you can use the Call divert service.

Note:
The Call divert service may not be available on all networks. Also, if you are using the 
Call restricting function, this may influence Call divert.

Selecting a data divert setting:
1. To obtain your current data divert settings from the network, click Retrieve.

2. Select Always if you want to divert all the incoming calls to a specific phone number. 

3. Select the Always check box and enter the destination number or click  to choose a phone 
number from your phone book. Click OK.

4. Click Apply to transfer your settings to your GC82. This may take a few seconds. 

Your data divert setting has now been stored in the network.

Restrict Calls

Restricting a certain type of call means that this type of call cannot be made to or from your GC82. 
You can restrict different types of outgoing and incoming calls. 

The following call types can be restricted:

• all outgoing calls.

• all outgoing international calls.

• all outgoing international calls except to your own country.

• all incoming calls.

• all incoming calls when you are abroad (when roaming).

A password, issued with your subscription, is required to turn a call restrict on or off. 
Contact your network operator for further information.
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Restricting Fax and Data Calls
To Change the call restrict status for fax and data calls:

1. To get your current call restrict settings from the network, click Retrieve. 

2. Tick the boxes next to the call types that you want to restrict.
Only select one outgoing and one incoming option.

3. When you have finished, click Apply.

4. Type your restriction password into the dialog and click OK.

Your call restrict settings have now been changed and stored in the network.
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GC82 Manager SMS Messages Screen

The GC82 Manager’s SMS Messages screen enables you to view, compose, edit, save, copy, delete, 
reply or forward SMS messages from your GC82 to other mobile devices. 

Note:
To use Message functionality SMS must be included in your subscription, contact your network 
operator for more details. 

The SMS Messages screen is split in to a left and right area.

The left area displays the folders; SIM SMS, Saved Messages, Sent Items and Unsent Items. 

The right area displays the contents of the selected folder. The top half of the right pane displays 
a list of received messages, sorted by date and the bottom half of the screen displays the content of a 
selected messages, this is referred to as the Information View.

The folders and their names are static, you can not change them.

Click to display the contents of the SIM Inbox. When GC82 Manager is opened any 
new SMS in the SIM Inbox are uploaded to the PC automatically. 
A status flag indicates whether a message is read or unread. 

If a new SMS arrives when the GC82 Manager is open  is displayed on the 
Status screen and the SMS audio sound is played, if enabled in the Setting dialog. 
See GC82 Manager Preferences on page 15.

If you want to keep an SMS, use the copy or move menu options to place it in the 
Saved folder. Click on the folder icon to display the contents of the Saved folder. 

A copy of each SMS that you have sent is stored in this folder. Click on the folder icon 
to display them. 

Any composed messages that have not been sent are displayed when you click 
on this icon. 
SMS stored in this folder can be edited or sent when the GC82 is connected. Any SMS 
that fail during transmission are also stored here, you can resend them at any time.

SMS
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Each time the SMS Messages screen receives a new SMS message from the SIM it checks the status 
of the SIM Inbox. If the SIM Inbox is full, a SIM Full icon is displayed in the left pane of the screen, 
see SIM Inbox is Full: on page 37.

Note:
For all the SMS Messages screen menu options to operate the GC82 must be registered 
successfully on a network. You must have a GSM signal to Send SMS, the button is disabled 
(grey) if you don’t have a signal.

Class 0 messages
If you receive a Class 0 message, it will appear in a pop-up dialog, which you can save or dismiss. 
If you choose to save the message it will be stored in you Saved Messages folder.

SMS Manager Functionality

To Send an SMS:
1. Select Create New Message... from the Messages menu or click .

2. The New Message dialog opens.

3. Enter the recipient’s mobile phone number in the To: field or select a number from a phone 
book by clicking Lookup...
To send an SMS to multiple numbers, hold down Ctrl when selecting the numbers from the 
phone book.

4. Type your message into the Message: field. 

5. If required you can click the Calculate SMS blocks to see how many SMSs your message will 
be split into. Also you can check the Request Status Report to get confirmation when the SMS 
arrives at its destination (if this service is supported by your network).

6. Click Send to send the SMS or Cancel to close the dialog without sending the SMS.

To Edit a Message:
When you are working with a message, you can edit the text by cutting, copying and pasting.

Moving Text:
1. Select the text you want to move, the text can be in another PC application.

2. Select Cut from the Edit menu or Ctrl and X on the keyboard. 

3. Place the cursor where you want to insert the text and select Paste from the Edit menu or Ctrl 
and V on the keyboard.

Note:
If you want to copy text, select Copy (Ctrl and C) from the Edit menu instead of Cut (Ctrl and X). 
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Reply to an SMS:
1. Select the folder where the message is located.

2. From the list, select the message you want to reply. The contents of the message are displayed in 
the information view.

3. Select Reply in the Messages menu. A dialogue appears. The To: field is automatically filled 
in and the original message is displayed in the Message: field.

4. If required you can click the Calculate SMS blocks to see how many SMSs your message will 
be split into. Also you can check the Request Status Report to get confirmation when the SMS 
arrives at its destination.

5. Type your reply and click Send. 

To Forward an SMS: 
1. Select the folder where the message is located.

2. From the list, select the message you want to forward. The contents of the message are displayed 
in the information view.

3. Select Forward in the Messages menu or click (forward icon), a dialogue opens. 

4. Enter the phone number in the To: field or click Lookup... to select a number from a phone book.
To send an SMS to multiple numbers, hold down Ctrl when selecting the numbers from the 
phone book.

5. If required you can click the Calculate SMS blocks to see how many SMSs your message will 
be split into. Also you can check the Request Status Report to get confirmation when the SMS 
arrives at its destination.

6. Click Send.

Delete an SMS: 
1. Select the folder where the message is located.

2. From the list, select the message you want to delete. The contents of the message are displayed 
in the information view.

3. Select Delete from the Edit menu, or press the Delete button on your keyboard.

4. A confirmation message box opens, click Yes to delete the message.

Note:
To delete all messages, click Select All from the Edit menu before you select Delete.

Folder Management:

Sorting SMS:
1. Select the folder where the messages you want to sort are located.

2. Click the Date column heading to sort the SMS in ascending or descending date order.
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Moving SMS:
1. Select the folder where the message you want to move is located.

2. From the list, select the message. The contents of the message are displayed in the 
information view.

3. Click Move to from the Messages menu. A progress dialog is displayed informing you that the 
SIM card is being updated.

4. The selected message is moved.

Note:
To move all messages, click Select All from the Edit menu before you select Move to.

Copy an SMS:
1. Select the folder where the message you want to copy is located.

2. From the list, select the message. The contents of the message are displayed in the 
information view.

3. Click Copy to from the Messages menu. A progress dialog is displayed informing you that the 
SIM card is being updated.

4. The selected message is copied.

Note:
To copy all messages, click Select All from the Edit menu before you select Copy to.

SIM Inbox is Full:
When the GC82 Manager detects the SIM SMS storage is full, it displays  on the Status screen 
and in the SMS Messages screen. You must move or delete some SMS from the SIM Inbox to free 
storage space so that you can continue receiving new SMS from the network. To do this you 
can either:

• Move your SMS from SIM SMS to Saved Messages 

• Right click on an SMS in SIM SMS and select delete.
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GC82 Manager Phone Book Screen

The GC82 Manager Phone Book screen helps you to organize your GC82’s SIM Phone Book.

The Phone Book Screen

A SIM Phone Book can easily become disorganized; you can use the Phone Book screen to manage 
your SIM Phone Book entries.

You can add new numbers, edit existing numbers, export and import entries. 

1. Click  to display the Phone Book screen.

2. Icons appear in the left pane representing the SIM Phone Book  and Saved Phone Book . 

You can manage your Phone Book entries by copying entries to the SIM Phone Book or the 
Saved Phone Book.

3. Click on the icon to display the Phone Book entries in the right pane.

Note:
Your GC82 must be inserted to display this information.

Phone Book Functionality

To Add a Number:
1. Select Add New in the Phone Book menu or click  on the toolbar or key Ctrl and N.

2. The New Phone Book Entry dialog opens.
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3. Enter the name and phone number.

4. Click OK to save the entry or Cancel to close the dialog.

Note:
Phone Book numbers are limited to 20 digits (including +) and names are limited 
to 18 alphanumeric characters. 

New entries are added to the next available SIM index position. 

To Modify a number:
1. Select the number you want to modify.

2. Select Modify... in the Phone Book menu.

3. The Edit Phone Book Entry dialog opens.

4. The fields in the dialog display the current entry’s name and number. 

5. Edit the information.

6. Click OK to save the entry or Cancel to close the dialog 
If the modified entry is in the SIM Phone Book the changes are automatically sent to the SIM.

To Find Entries:
1. Select Find in the Phone Book menu or key Ctrl and F.

2. The Find dialog opens. Enter the text or number you want to search for in the Look for field. 
The entry can be complete or incomplete.

3. Click Find. The GC82 Manager searches both Phone Books, when a match is found 
it is displayed in the right pane. Click Find Next to search again.

4. Click Close when you have finished searching.

To Copy an Entry:
1. Select an entry from the SIM Phone Book or the Saved Phone Book.

2. Select Copy To in the Phone Book menu. The Copy To option is followed by the name of the 
Phone Book you haven’t selected the entry from.

3. A duplicate entry is made in the specified Phone Book. The new entry is assigned the next 
available position in the destination Phone Book.

To Move an Entry:
1. Select an entry.

2. Select Move To in the Phone Book menu. The Move To option is followed by the name of the 
Phone Book you haven’t selected the entry from.

3. The entry is moved from its current Phone Book and placed in the selected one. The new entry 
is assigned the next available position in the destination Phone Book.
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To Import an Entry or Phone Book:
1. Select Import from the Phone Book menu.

2. Select the Replace Existing Phone Book or Merge with existing Phone Book radio button.

3. Click  and browse to find the file you want to import.

Note:
The file must be a text file in comma separated value (CSV) format. Any invalid lines or files 
will be ignored.

4. Click OK in the browse dialog. The path and file name are displayed in the Import File 
Name field.

5. Click Import to complete the import procedure.

To Export an Entry or Phone Book:
1. Highlight the entries or open the Phone Book you want to export.

2. Select Export from the Phone Book menu.

3. Select All to export the entire Phone Book or Selected Items to export the highlighted entries.

4. Type a name for the file into the Export File Name field.

5. Click  and identify the save location.

Note:
The file will be saved as a text file in comma separated value (CSV) format.

6. Click OK in the browse dialog. The path and file name are displayed in the Export File 
Name field.

7. Click Export to complete the procedure.
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Delete a number 
1. Select the number that you want to delete.

2. Select Delete, from the Edit menu.

3. A confirmation dialog opens, click Yes to delete the number.

Note:
If you want to delete all numbers, select Select All from the Edit menu before clicking Delete.

To Send a New SMS Message:
1. Select an entry from a Phone Book.

2. Select Create New Message from the Messages menu.

3. A new SMS Message dialog is opened and pre-addressed with the selected entries details.
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42 GC82 Manager Online Services Screen

GC82 Manager Online Services Screen

Online Services is a customized service offered by a network operators. This service is network or 
subscription dependant. The Online Services screen provides a mechanism that allows applications 
that exist on the SIM to interact and operate with the GC82. Typical services offered by network 
operators include: 

• sports scores

• news

• financial data

• horoscopes

• interactive text game messages

Online Services are placed on your SIM card by your operator. GC82 Manager detects if these 
services are on the SIM card and displays the  if they are.

1. Click  to display the Online services screen. You can also select to display the Online 
Services screen from the View menu. 

The screen displays a menu of the online services offered by your network operator.

Click on the category you require and click Select. 

More detailed choices are sometimes displayed, if necessary select the required option and 
click Select. 

The response may take various forms, depending on the network operator. For example, the news 
headlines might be sent as an SMS, which will be delivered to the SMS inbox.

Online Services menus are sometimes used to provide a list of voice-based services such as directory 
enquiries. If one of these is selected, you will not be connected because the GC82 does not support 
voice calls.

Note:
Contact your operator to find out which services are available for your account.

i
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Troubleshooting

This chapter lists some problems that you might encounter while using your GC82. Some problems 
require you to contact your service provider, but most of the problems you can easily correct yourself.

GC82 Manager Icon Errors

Software Errors

Error Messages

General

 appears 
in the task bar

Indicates that the Radio is turned off. Right click the CMI, 
select Radio Settings from the sub menu, select On.

 appears 
in the task bar

Indicates that the GC82 cannot find a network, there is no network 
within range or the received signal is too weak. You have to move 
to get a stronger signal.

A signal is 
present but you 
can’t connect 
to the GPRS 
network

Indicates that a GSM network is present, but no GPRS service 
is available. This can be caused by; no GPRS service in the area, 
you are trying to roam on a network for which no GPRS roaming 
agreement exists or there is a temporary fault on the network. 
Contact your network operator for more details.

 appears 
in the task bar

GC82 isn’t present, please insert.

Grey menu 
options in the 
software 
applications

Grey text indicates a function that is temporarily unavailable, 
for example due to your subscription or due to a certain setting 
which has not been turned on.

Modem not 
responding.... 
Error

Check the radio is turned on.

Dial-Up fails Try to connect again.
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SIM Card Errors

Error Codes

Windows® 98

Wrong PIN/ 
Wrong PIN2

You have entered your PIN or PIN2 incorrectly. Enter the correct 
PIN or PIN2, and click OK. See SIM lock on page 29

Codes do not 
match

When you want to change a security code (for example your PIN) 
you have to confirm the new code by entering it again. This error 
occurs when the two codes, that you have entered do not match. 
See Phone lock on page 28.

PIN blocked/ 
PIN2 blocked

You have entered your PIN or PIN2 incorrectly three times 
in succession. To unblock, see SIM lock on page 29.

PUK blocked – 
contact operator

You have entered your personal unblocking key code (PUK) 
incorrectly 10 times in succession. Contact your network operator 
or service provider.

Error 619: 
The port is 
disconnected 
during dial-up

An ISDN mode (V110 or V120) has been selected when creating 
a connection, but is not supported by the network.
Select Analogue mode when creating the connection in the 
Connection Wizard.

Error 629: 
The port was 
disconnected 
by the remote 
machine during 
dial-up

Telephony settings are set to pulse dialling, change to tone dialling.

Check the dialling settings for the current location (In Control 
Panel  Phone and Modem Option  Dialling Rules  
Location  Edit) and change the Dial using setting to tone, 
or (if Pulse is a necessity), create a new location called GC82 
Anywhere and set the dialling to Tone. GC82 anywhere location 
should then be used whenever you use the GC82.

Error 630: 
The port was 
disconnected 
due to hardware 
failure during 
dial-up

A Dial-up networking connection is already connected. 
Close the connected dial-up and try again.

Error 645: 
Internal 
authentication 
error during 
dial-up

Incorrect APN or CID selected for network.
Modify your Dial-up Connection, see Create a Connection on page 
21 for more details. Make sure that the APN file contains the name 
of the access point your network operator is using. See the support 
section on www.SonyEricsson.com site for a full list of network 
operator APNs.

Error 650: The 
Remote Access 
server is not 
responding 
during dial-up

Incorrect User ID and/or password. Re enter correctly.
44 Troubleshooting

http://www.SonyEricsson.com


Windows® 2000

Error 678: 
Computer you 
are dialling is 
not responding 
during dial-up

Either: Service is not supported by SIM (usually for CSD) or the 
computer is not answering.

1 Check SIM settings with your service provider if necessary,

2 Make sure that the server you are dialling is OK,

3 Make sure that Analogue mode has not been selected with 
57.6kbps data rate (V110 or V120 mode must be selected 
and supported by the network)

Error 720: 
No PPP control 
protocols 
configured 
during dial-up

The service is not supported by the SIM, usually appears when 
you are trying to connect to GPRS Internet. Contact service 
provider to enable GPRS Internet access on SIM card

Error 619: The 
port is 
disconnected 
during dial-up

An ISDN mode (V110 or V120) has been selected when creating 
a connection, but is not supported by the network.
Select Analogue mode when creating the connection in the 
Connection Wizard.

Error 678: 
Computer you 
are dialling is 
not responding 
during dial-up

Either: Service is not supported by SIM (usually for CSD) or the 
computer is not answering.

1 Check SIM settings with your service provider if necessary.

2 Make sure that the server you are dialling is OK.

3 Make sure that Analogue mode has not been selected with 
57.6 kbps data rate (V110 or V120 mode must be selected 
and supported by the network).

Error 691: 
Access denied, 
user name and 
password 
incorrect on the 
domain during 
dial-up

The domain name entry is incorrect.
Correct the domain name entry or delete if not required.

Error 718: 
The card was 
unable to dial 
during dial-up

This error indicates a PPP conversation started, but it was 
terminated because the remote server did not respond within 
an appropriate time. This can be caused by poor line quality 
or a problem with the server (ISP). This error can occur when 
your modem has connected to the ISP and has sent a username 
and password, but there is no response from the server. 
Wait a few minutes and try again
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All Windows® Operating Systems

Error 734: The PPP link 
control protocol was 
terminated during dial-up

The APN entry is incorrect, the signal is weak or the 
connection is lost whilst dialling.
See the support section on www.SonyEricsson.com 
site for a full list of network operator APNs.

Error 678: Computer 
you are dialing is not 
responding during dial-up

Either: Service is not supported by SIM (usually for CSD) 
or the computer is not answering.
Check SIM settings with your service provider if necessary.
Make sure that the server you are dialing is OK.
If you are unsure which speed to choose from the Speed 
tab, start with Analogue 9600, and check to see if it works. 
Once your connection works on Analog, you can try the 
V110/V120 settings to see if faster speeds are available. 
V110/V120 also connects faster than analog. When 
roaming you may need to repeat this procedure to adapt 
your settings to the capability of the local network operator.

Connection Failed 
or Activation Failed. 
Please contact your 
Service Provider.

No specific reason for failure is available. Wait a few 
minutes and try again. If you continue to get this error 
check your connection settings or call your service provider 
for help.

Connection Failed. Invalid 
APN. Please check and 
enter the APN again.

The APN entry is incorrect, the signal is weak or the 
connection is lost whilst dialing. See the support section 
on www.SonyEricsson.com site for a list of network 
operator APNs or contact your service provider.

Connection Failed. Invalid 
User Name or Password. 
Please check and enter the 
User Name and/or 
Password in your 
connection profile.

Choose to modify your connection in the Connection 
Wizard. Go to the User ID screen and re enter the User 
Name and Password given to you by your service provider. 
If you were not supplied with a User Name and Password 
leave the fields blank. Contact your service provider if you 
continue to have problems.

Connection Failed. Invalid 
Profile. Please check and 
re-enter your connection 
profile information, and 
try again. If the problem 
continues please contact 
your Service Provider.

Your service provider doesn’t recognise you. Check the 
setting you have entered to create your connection. If you 
still get the error contact your service provider and check 
you have GPRS Internet enabled on your subscription and 
then setting you should enter to create a connection.

Disconnected from 
Network

You have been disconnected from the network. Wait a few 
minutes and try again. If the problem persists contact your 
service provider.

Connection failed. 
Temporary Network 
problem. 
Please try again. If the 
problem continues please 
contact your Service 
Provider.

This error indicates a PPP conversation started, but it was 
terminated because the remote server did not respond 
within an appropriate time. This can be caused by poor line 
quality or a problem with the server (ISP). This error can 
occur when your modem has connected to the ISP and has 
sent a username and password, but there is no response 
from the server. 
Wait a few minutes and try again
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Connection Failed. 
Not authorised to access 
network. Please contact 
your Service Provider.

Your service provider doesn’t think your authorised to 
access their network. Check the setting you have entered 
to create your connection. If you still get the error contact 
your service provider and check your subscription.

Connection Failed. 
SIM is invalid for GPRS 
service. Please contact 
your Service Provider.

Contact your service provider and request the GPRS 
Internet subscription is activated for your SIM.

Connection Failed. Access 
to network not allowed. 
Please contact your 
Service Provider.

Your service provider is not allowing you to access their 
network. Check the setting you have entered to create your 
connection. If you still get the error contact your service 
provider and check your subscription.

Connection Failed. 
Roaming not allowed. 
Please contact your 
Service Provider.

Contact your service provider to get your roaming 
activated.

Connection Failed. Please 
try again. If the problem 
continues please contact 
your Service Provider.

You couldn’t connect to the network. Wait a few minutes 
and try again. If the problem persists contact your service 
provider.

Connection Failed. Service 
not supported. Please try 
again. If the problem 
continues please contact 
your Service Provider.

Your service provider is not allowing you to access their 
network. Contact your service provider and check you have 
the subscriptions required activated for your SIM.

Connection Failed. 
Network Problem. Please 
try again. If the problem 
continues please contact 
your Service Provider.

You couldn’t connect to the network. Wait a few minutes 
and try again. If the problem persists contact your service 
provider.
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Additional Information

Sony Ericsson Support Web Site

At www.SonyEricsson.com/support you can find help and tips in a few clicks. The support site 
gives you access to:

• the latest software updates

• tips on how to use your GC82 efficiently

• function guides 

• additional help

Important Information

Please read this information before using your GC82.

Recommendations
• Always treat your product with care and keep it in a clean and dust-free place.

• Do not expose your product to liquid, moisture or humidity.

• Do not expose your product to extreme high or low temperatures.

• Do not expose your product to open flames or lit tobacco products.

• Do not drop, throw or try to bend your product. 

• Do not paint your product.

• Do not attempt to disassemble your product. Only Sony Ericsson authorized personnel should 
perform service.

• Do not remove the SIM

Antenna 
Only use an antenna that has been specifically designed by Sony Ericsson for your GC82. 
Use of unauthorized or modified antennas could damage your GC82.

Children
Do NOT allow children to play with your GC82. They could hurt themselves or others, or could 
accidentally damage the GC82. Your GC82 may contain small parts that could be detached and 
create a choking hazard.

Disposing of the Product 
Your GC82 should not be placed in municipal waste. Please check local regulations for disposal 
of electronic products.
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Electronic Devices 

Most modern electronic equipment, for example equipment in hospitals and cars, is shielded from 
RF energy. However, certain electronic equipment is not, therefore: 

Do not use your GC82 near medical equipment without requesting permission. 

The GC82 may affect the operation of some implanted cardiac pacemakers and other medically 
implanted equipment. Pacemaker patients should be aware that the use of a GC82 very close to a 
pacemaker might cause the device to malfunction. Avoid placing the GC82 over the pacemaker. If 
a minimum distance of 15 cm (6’’ inches) is kept between the GC82 and the pacemaker, the risk of 
interference is limited. If you have any reason to suspect that interference is taking place, 
immediately turn off your GC82. Contact your cardiologist for more information. 

If you use any other personal medical device, consult the manufacturer of your device to determine 
if it is adequately shielded from external RF energy. 

Turn your GC82 off in any facility where posted notices so require. 
 
 
Aircraft 

You MUST remove your GC82 before boarding any aircraft. 

To prevent interference with communication systems and abide by the law, you must not use your 
GC82 while the plane is in the air. 

Do not use it on the ground without permission from the crew. 
 
 
Blasting Areas 

Turn off your GC82 when in a blasting area or in areas posted turn off two-way radio to avoid 
interfering with blasting operations. Construction crews often use remote control RF devices to set 
off explosives. 

 
 
Explosive Atmospheres 

Turn off your GC82 when in any area with a potentially explosive atmosphere. It is rare, but your 
GC82 could generate sparks. Sparks in such areas could cause an explosion or fire resulting in 
bodily injury or even death. 

Areas with a potentially explosive atmosphere are often, but not always, clearly marked. They 
include fuelling areas, below deck on boats, fuel or chemical transfer or storage facilities, and areas 
where the air contains chemicals or particles, such as grain, dust, or metal powders. 

Do not transport or store flammable gas, liquid, or explosives in the compartment of your vehicle, 
which contains your GC82 and accessories. 

 
 
Inserting and removing the SIM card – precautions against electrostatic discharge (ESD) 

Do not touch the SIM card connectors. As a precaution, always make sure that the GC82 is already 
in your hand before you insert or remove the SIM card. 

 
 
Radio wave exposure and Specific Absorption Rate (SAR) information 

This PC card modem is a low-power radio transmitter and receiver. When it is turned on, it emits 
low levels of radio frequency energy (also known as radio waves or radio frequency fields). 

Governments around the world have adopted comprehensive international safety guidelines, 
developed by scientific organizations, e.g. ICNIRP (International Commission on Non-Ionizing 
Radiation Protection) and IEEE (The Institute of Electrical and Electronics Engineers Inc.), through 
periodic and thorough evaluation of scientific studies. These guidelines establish permitted levels 
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of radio wave exposure for the general population. The levels include a safety margin designed to 
assure the safety of all persons, regardless of age and health, and to account for any variations in 
measurements. 

Specific Absorption Rate (SAR) is the unit of measurement for the amount of radio frequency 
energy absorbed by the body when using a low-power radio transceiver designed for body worn or 
head held use. The SAR value is determined at the highest certified power level in laboratory 
conditions, but the actual SAR level of the low-power radio transceiver while operating can be well 
below this value. This is because the low-power radio transceiver is designed to use the minimum 
power required to reach the network. 

Variations in SAR below the radio frequency exposure guidelines do not mean that there are 
variations in safety. While there may be differences in SAR levels among PC card modems, all 
Sony Ericsson PC card modem models are designed to meet radio frequency exposure guidelines. 

Before a PC card modem is available for sale to the public, it must be tested and certified to the 
FCC that it does not exceed the limit established by the government-adopted requirement for safe 
exposure. The tests are performed in positions and locations as required by the FCC for each model. 
For body worn operation, this PC card modem has been tested and meets FCC RF exposure 
guidelines for fixed and mobile use when the PC card modem is installed in a PCMCIA card slot of 
a standard Laptop PC with the original antenna. 

Sony Ericsson has not measured, and makes no representation about, the body worn SAR levels 
when the modem card is used in any portable host equipment or when any changes to the original 
product has been made.  
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Technical Specifications

Exterior Description

Ambient Temperatures

Electrical Characteristics

Product name GC82

System GSM 850
GSM 1900

Services supported CSD, GPRS/EDGE, SMS, Fax
Speech services are not supported

SIM Card Small plug-in card, 3V type
SIM Lock supported
Regular (non-GPRS-aware) and GPRS-aware SIMs 
supported

Type Number 6130201-BV

Size PC Card Type II, 16 bit
85.6 mm long x 54.0mm wide x 5.0 mm thick

Weight 38g including antenna, excluding SIM card

Battery Powered via the PC card slot i.e. uses laptop battery

Antenna 50 ohm interface; Antenna supplied

Operating -10 to 55 degrees C

Storage -20 to 65 degrees C

Supported Voltages 3.3V ± 10%

Nominal Operating Voltage 3.6V

Standby Current 4.2mA

Standby Power Consumption (no PDP context 
active)

13.86mW

Idle current (9/2 multiframe paging period) 
(PDP context active)

5.0mA/7.6mA

Idle power (9/2 multiframe) 16.5mW/25mW

Maximum Current 800mA

Maximum Power Consumption 1W
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Operating System Support

GSM Performance and technical characteristics

GSM Features Supported

Supported Operating 
Systems

Microsoft Windows
 98 (SE)

Microsoft Windows
 Me

Microsoft Windows
 2000 (SP2)

Microsoft Windows  XP

Minimum PC 
Specification

Processor size as recommended by Microsoft for the 
version of Windows® in use
PC Card slot
30 MB free disk space

Dimension GSM 850 GSM 1900

Frequency Range TX: 824 – 849 MHz
RX: 869 – 894 MHz

TX: 1850 – 1910 MHz
RX: 1930 – 1990 MHz

Channel Spacing 200 kHz 200 kHz

Number of Channels 124 Carriers * 8 (TDMA) 299 Carriers * 8 (TDMA)

Modulation GMSK/8-PSK GMSK/8-PSK

Power Classes Class 4 (2W) for GSM/
GPRS and EGPRS/MCS 
1-4 (GMSK);
Class E2 (0.5W) for 
EGPRS/MCS 5-9 (8-PSK)

Class 1 (1W) for GSM/GPRS 
and EGPRS/MCS 1-4 
(GMSK);
Class E2 (0.4W) for EGPRS/
MCS 5-9 (8-PSK)

Transmitter Output 
Impedance

50Ω 50Ω

Transmitter 
Spurious Emission

According to GSM 
specification

According to GSM 
specification

ME SIM Lock Yes

SIM Application 
Toolkit

Class 2 without call control.
Support is provided via AT commands

USSD Support is provided via AT commands; No MMI is provided

Speech Coding Not applicable (GC82 does not support speech services)
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CSD technical data

GPRS technical data

Standards AT commands industry standard ETSI 07.05, 07.07 and 
07.10, V.25ter command set supported

CSD Data Rates 9.6 kbps or 14.4 kbps depending on the GSM network

Compression MNP5 (Increases data rate up to 2x depending on data type)
V.42bis (Increases data rate up to 4x depending on data type)
GSM network support required for compression

Error Correction End to End MNP2 and LAPM (V.42)
RLP
Requires GSM Network support

GSM/ISDN According to V.110 and V.120

GPRS Specification 
SMG

SMG31bis

Data Rates Multislot class 10 supported (see table below).
Coding schemes: CS-1, CS-2, CS-3 and CS-4

Mode of Operation Class B (attaches to both GSM and GPRS at the same time; 
data connection is established using CS (CSD/fax) or GPRS) 
The user may select CSD or GPRS modes via Dial-Up 
Networking configurations in Windows

Attach Modes GPRS Attach
GPRS Detach
Combined Attach (CS+GPRS) (CCCH)
Combined Detach (CCCH)
Combined Attach (CS+GPRS) (PCCCH)
Combined Detach (PCCCH)

Network modes Network Mode 1
Network Mode 2
Network Mode 3

R Reference Point Physical layer: RS232 virtual COM port
Authentication mechanisms PAP and CHAP supported

IP Connectivity PDP type IP is supported
IPv4, terminated in Windows® DUN

SMS over GPRS Mobile Originated and Mobile Terminated

QoS Support for all 4 classes.
QoS Negotiation.
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GPRS Maximum Data Rates

Speed achieved depends on the Coding Scheme supported by the GSM Network. The speeds given 
are maximums, Sony Ericsson cannot guarantee how fast your network will operate.

Data rate is the payload per slot, header plus data.

EDGE Technical Data

PDP Context Up to 10 PDP context details are stored in GC82 memory. 
PDP Context description edited via supplied Wizard or AT 
command.
Number of parallel PDP Context activated (both MO and 
MT):1
Number of PDP Context with traffic in parallel:1
PDP Context modification (e.g. QoS renegotiation).
Network initiated PDP Context modification.
Network initiated PDP Context deactivation.
Collision of MS and Network initiated PDP Context activation.

SIM Support for GPRS aware as well as non-GPRS-aware SIMs

Compression TCP/IP Header Compression
V42bis

GPRS Encryption GEA1

GPRS Frequency 
Hopping

Supported

GPRS IP allocation Dynamic
Static

CS-1 
9.05 kbps

CS-2 
13.4 kbps

CS-3 
15.6 kbps

CS-4 
21.4 kbps

4 + 1 RX 36.2 53.6 62.4 85.6

TX 9.05 13.4 15.6 21.4

3 + 2 RX 27.15 40.2 46.8 64.2 

TX 18.1 26.8 31.2 42.8

Modulation Coding 
Schemes

MCS-1 to MCS-9

EDGE features Link Adaptation 
Incremental Redundancy
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EDGE Maximum Data Rates

Speed achieved depends on the Coding Scheme supported by the GSM Network. The speeds given 
are maximums, Sony Ericsson cannot guarantee how fast your network will operate.

Data rate is the payload per slot, header plus data.

SMS Technical Data

4 + 1 3 + 2

Coding 
Scheme

Data Rate 
per slot

Rx Tx Rx Tx

MCS-1 10.60 42.40 10.60 31.80 21.20

MCS-2 13.00 52.00 13.00 39.00 26.00

MCS-3 16.60 66.40 16.60 49.80 33.20

MCS-4 19.40 77.60 19.40 58.20 38.80

MCS-5 24.05 96.20 24.05 72.15 48.10

MCS-6 31.25 125.00 31.25 93.75 62.50

MCS-7 47.45 189.80 47.45 142.35 94.90

MCS-8 57.05 228.20 57.05 171.15 114.10

MCS-9 61.85 247.40 61.85 185.55 123.70

Concatenated SMS Yes.

SMS Cell Broadcast Supported in GC82 Manager and by AT Commands 
(excluding Cell ID)

SMS Immediate 
Display

Supported in GC82 Manager and by AT Commands.

SMS interface GC82 Manager, Communications Suite, pocket PC 
Suite. 
AT Command
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Software Upgrade

Fax Technical Data

Supported Languages

PC Card software 
upgrade

Via secure internet download (Sony Ericsson Update 
Service) or at a Sony Ericsson Service Points.

PC Communications 
Suite upgrade

Internet download

Machine groups Class 2, Group 3 and 4

Speed 9.6kbps

Verified applications Microsoft Fax (Windows 200 and XP; may require installing), 
Symantec and Winfax  PRO 10  (not supplied).

Quick Start Guide
PC Software
User’s Guide (PDF)

English (EN)
Canadian French (FR)
Spanish (ES)

AT Commands 
Manual

English
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License Agreement

License
Any use of the enclosed compact disc, diskette or any other media including upgrades thereof (“the 
Software”) shall be in accordance with the below stated license terms and conditions. By opening 
the sealed Software package and/or using the Software you agree to be bound by the terms and 
conditions stated below. These terms and conditions are binding and create a legal obligation (the 
“License Agreement”) between you (the “Licensee”) and Sony Ericsson Mobile Communications 
AB (the “Vendor”). 

The Software licensed hereunder may be delivered in an inseparable package also containing other 
software programs than this particular Software (e.g. bundled with other software). As a safeguard 
you should not in any way use the other software programs before reading the specific license terms 
and conditions of such other software.

License

You are hereby granted a non-transferable, non-exclusive right to use (“License”) the Software. 

You may only (a) use this Software on one single computer at a time; (b) physically transfer the 
Software from one computer to another if the Software is used only on one computer at a time 
and provided you remove any copies of the Software from the computer from which the Software 
is being transferred and/or on which it was originally used; (c) if necessary, make copies of the 
Software solely for purposes of backup. The copyright notice must always be reproduced and 
included on a label on any backup copy. 

You may not according to the EC Council Directive of May 14, 1991 on the legal protection 
of computer programs (91/250/EEG) (the “Software Directive”) distribute any copy of this Software 
or its documentation to others; nor modify, rent, lease or grant any rights to this Software whatsoever 
to another person or entity. In addition, you may not translate, reverse engineer, decompile, 
disassemble, reproduce or otherwise alter or modify the Software, its source code, documentation 
nor disclose any information designated as confidential or proprietary at the time of disclosure or, 
information which by its nature, is confidential or proprietary.

Term

Your License remains effective from the date of your cash receipt/proof of payment until terminated. 
You can terminate your License at any time by destroying the Software together with all copies 
of the Software in whichever form they may be. Your License will automatically terminate without 
prior notice if you fail to comply with any term or condition of this Agreement. In the event of 
termination of your License you must immediately destroy all copies of the Software in whichever 
form they may be.

Limited Warranty

Vendor warrants the media on which the Software is provided, to be free from defects in materials 
and workmanship under normal use for ninety (90) days after the date of your cash receipt/proof 
of payment. The Vendor's and its suppliers' entire liability and your exclusive remedy under this 
warranty will at Vendor's option be (and provided you return the Software to an authorized reseller/
supplier together with a copy of your cash receipt/proof of payment), to replace the disc(s)/ 
diskette(s) or refund the purchase price and terminate this Agreement including the License.
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Except for the above express limited warranties, Vendor and its suppliers do not provide nor do you 
receive any warranties or conditions whether express, implied, statutory or otherwise and Vendor 
and its suppliers specifically disclaim any implied warranties of satisfactory quality and/or fitness 
for a particular purpose. If your jurisdiction does not allow limitations on implied warranties 
to consumers, the above limitation may not apply to you. 

Vendor does not warrant that your use of the Software will be uninterrupted or error free. You assume 
full responsibility for the selection of this Software and your selected hardware and for the Software 
and hardware together achieving your intended results, as well as for any installation or use 
of or result obtained from the Software.

Intended use

The Software shall be used in accordance with the instructions and for its intended use and purpose 
only. The Software or part thereof may not be used in e.g. life support systems, nuclear facility 
applications, nor for the purposes of missile technology, chemical or biologized industry, flight 
navigation or communication of air, ground support equipment or other similar business or for any 
other purpose where any failure by the Software to perform may result in personal injury, death, 
damage to tangibles or the environment.

Limitation of liability

In no event shall Vendor or its suppliers be liable for any indirect or consequential losses or damages 
whatsoever irrespective of the cause for such losses or damages, including loss of data, loss of 
business profits or revenue, or any business interruption arising out of the use of or inability to use 
this Software. Vendor and its suppliers’ total liability under this Agreement shall be limited to the 
amount actually paid by Licensee for the Software.

Disputes and Governing Law

The validity, construction and performance of this Agreement shall be governed by the laws 
of Sweden. All disputes, differences or questions between the parties with respect to any matter 
arising out of or relating to this Agreement shall be finally settled under the Rules of Conciliation 
and Arbitration of the International Chamber of Commerce, in Stockholm, by three (3) arbitrators 
appointed in accordance with the said Rules. The proceeding shall be conducted in the English 
language.
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FCC Statement 
 
 
 

This device complies with Part 15 of the FCC rules. Operation is subject to the following two 
conditions: 

(1) This device may not cause harmful interference, and 

(2) The device must accept any interference received, including interference that may cause 
undesired operation. 

 

GC82: 

FCC-ID: PY7F1041011 

IC: 4170B- F1041011 
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Appendix A - Connection Parameters

General Connection Parameters for CSD and GPRS

Required Useful information

Telephone 
number or 
Access Point 
Name (APN)

Number you need to dial to reach your service provider. Use the full 
number including country code and area code, e.g. +46 33 555 2525.
Or
The APN server resource to contact, for example, 
Interent.operator.net - to connect to the Internet via the mobile operator’s 
or your corporate Intranet via a VPN

Bearer 
capability:
CSD or GPRS?

You will need to know the bearer capability provided by your service 
provider, so you can select the appropriate option during set up.

CSD Network 
Speed

If you intend to create connections via CSD contact your network operator 
and check the supported speeds.

Username The username your service provider gave you when the account was set 
up. Some dial-up accounts do not require a Username, in this case leave 
the field blank.

Password Password associated with the username, given to you by the service 
provider. Some dial-up accounts do not require a Password, in this case 
leave the field blank.

IP assignment: 
Server / Static

An ‘address’ that the service provider knows you by and uses to route 
information to and from your GC82. Your IP address will either be:
Server - assigned by the service provider when you connect. 
Static - assigned once by the service provider or the IT Manager.
If your IP address is Static you must enter it into Own IP address fields 
which is available when you select Details in the Connection APN dialog.

DNS 
assignment:
Server / Static

This tells the GC82 where to find the service provider’s DNS Service. 
DNS translates addresses such as www.sonyericsson.com to the numeric 
IP address so that the information can be accessed.
Like IP assignment above, the DNS can be static or allocated by the 
service provider when you connect. If static is selected additional fields 
need to be completed containing the static information.

Own IP address Only required if the IP assignment is static.
Format example: 123.9.45.3. 
Do not enter any leading 0s when typing in IP address.

Primary DNS Only required if the DNS assignment is static.
Format example:123.9.45.2

Secondary DNS Only required if the DNS assignment is static.
Format example: 123.9.45.1

Access Point 
Name (APN)

If the APN is set to default you will have to enter the name of the access 
point your network operator is using.
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CSD Specific Parameters

* Only available with ISDN V.110 or V.120 connection mode.

Required Useful information

Preferred 
Connection 
Speed (bits/s)

Select your preferred network connection speed from the drop down 
list provided:
9600, 14400, 19200, 28800, 38400, 43200* or 57600*

Connection 
Mode

Select the method you want to use to connect to the network from the 
options provided:
analogue, ISDN V.110 or ISDN V.120

Compression Use to speed up data transfer. You can select to Enable Data 
Compression and Header Compression.

Callback 
Number

Enter the number the a callback should be made to. You can only use 
Callback if you are connecting to a source that gives permission for 
callbacks to be made, for example your company server.
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Glossary

Bearer

Path over which data flows. Specifically in CSD the type 
of telephony link from the GSM network to the server - 
V PSTN or ISDN.

bps

Bits per second - rate of data flow.

COM Port

Defines a serial/RS-232 port within the Windows® 
environment. May be physical (COM1 port on the rear 
of the PC) or virtual (COM5 port communicating with 
a PC card modem)

CS

Circuit Switched. Connection from A to B which has 
a fixed bandwidth and is maintained over a period 
of time, for example a voice telephone call.

CS-1 to CS-4

Coding Scheme. Determines the data rate per timeslot 
in GPRS.

CSD

Circuit Switched Data. CSD is a GSM service providing 
a CS data connection at a rate of 9.6 or 14.4 kbps.

DUN

Dial-Up Networking.

EDGE

Enhanced Data rates for Global Evolution.

e-GSM

Extended GSM. New frequencies specified by the 
European Radio Communications Committee (ERC) 
for GSM use when additional spectrum is needed 
(Network-dependent). It allows operators to transmit 
and receive just outside GSM’s core 900 frequency 
band. This extension gives increased network capability.

ETSI

European Telecommunications Standards Institute. 
www.etsi.org

GGSN

Gateway GPRS Support Node

GPRS

General Packet Radio Services.

GSM

Global System for Mobile Communications. GSM is the 
world’s most widely-used digital mobile phone system, 
now operating in over 160 countries around the world.

GSM 900

The GSM system family includes GSM 900, GSM 1800 
and GSM 1900. There are different phases of roll-out for 
the GSM system and GSM phones are either phase 1 
or phase 2 compliant.

GSM 1800

Also known as DCS 1800 or PCN, this is a GSM digital 
network working on a frequency of 1800 MHz. It is used 
in Europe and Asia-Pacific.

GSM 1900

Also known as PCS. Refers to a GSM system running 
in the 1900MHz band. Used in the USA and Canada, 
for instance.

HTML

HyperText Markup Language.

HTTP

HyperText Transfer Protocol.

ISDN

Integrated Services Digital Network. Can provide 
circuit-switched data connections in multiples 
of 64 kbps.

ISP

Internet Service Provider.

kbps

Kilobits per second - rate of data flow.
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LAN

Local Area Network.

ME

Mobile Equipment.

MO

Mobile Origination. For example, an SMS message sent 
from a mobile terminal.

MMI

Man-Machine Interface.

MS

Mobile Station.

MT

Mobile Termination.

PC

Personal Computer.

PCS

Personal Communications Services, often used 
to describe GSM1900 networks.

PC Card

A card having physical and electrical characteristics 
specified by PCMCIA providing extra functionality 
when inserted into a laptop PC. Typical examples are 
modems and network cards. Type refers to the thickness 
of the card. The GC82 is type II.

PCMCIA

Personal Computer Memory Card International 
Association – defines specifications for PC Cards. 
www.pcmcia.org

PDP

Packet Data Protocol.

Phone book

A memory in the SIM card where phone numbers can 
be stored and accessed by name or position.

PSTN

Public Switched Telephone Network, for example 
ordinary analogue phone line for speech and/or 
computer modem.

RADIUS

Remote Access Dial-In Service. Facility at the ISP 
or corporation to manage remote data connections.

RX

Receive

SC

Service Centre (for SMS).

Service Provider

A company that provides services and subscriptions 
to GC82 users.

SIM card

Subscriber Identity Module card – a card that must be 
inserted in any GSM-based mobile terminal. It contains 
subscriber details, security information and memory for 
a personal directory of numbers. The card can be a small 
plug-in type or credit card-sized, but both types have the 
same functions. The GC82 uses the small plug-in card.

SMS

Short Message Service. Allows messages 
of up to 160 characters to be sent and received via 
the network operator's message centre to a GC82.

TCP/IP

Transmission Control Protocol/Internet Protocol.

TCP/IPv4

TCP/IP Version 4. Most widely implemented form 
of TCP/IP today having a 4 byte address format such 
as 212.161.127.136.

TE

Terminal Equipment. Generic term for GSM terminals 
such as phones and PC cards.

Terminal Adaptor

Generic term for the equipment terminating a digital 
comms line such as an ISDN2 line. The GC82 
is a Terminal Adaptor since it interfaces to GSM 
digital data services.
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TLS

Transport Layer Security. Used by Web browsers, 
for example.

TX

Transmit

Type II

Refers to thickness of a PC Card as defined in the 
specification from PCMCIA.

URL

Uniform Resource Locator.

USSD

Unstructured Supplementary Services Data. 
Narrow-band GSM data service. For example entering 
*79*1234# might return the stock price for stock 1234.

V.110

ETSI standard for data over an ISDN circuit.

V.120

ETSI standard for data over an ISDN circuit.

VPN

Virtual Private Network.

WWW

World Wide Web.

XML

Extensible Markup Language
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